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بسم الله الرحمن الرحیم یا اسماء متبرکه با شکل دلخواه و بنا به انتخاب نگارنده در این صفحه درج گردد.






















تعهد نامه اصالت اثر (سبک: تیتر)

[bookmark: _Hlk75506603]اینجانب ........................................ دانشجوی کارشناسی رشته  .......................  مجتمع آموزش عالی لارستان اعلام می‌دارم که پایان‌نامه با عنوان   ............................................................................................................................. با راهنمايي جناب آقاي/سركار خانم ...........................................  توسط شخص اینجانب انجام شده و متعهد می شوم که مطالب مندرج در این پایان نامه حاصل کار پژوهشی اینجانب تحت نظارت و راهنمایی اساتید مجتمع آموزش عالی لارستان بوده و به دستاوردهای دیگران که در این پژوهش از آنها استفاده شده است مطابق مقررات و روال متعارف ارجاع و در فهرست منابع و مآخذ ذکر گردیده است. ضمناً این پایان نامه قبلا برای احراز هیچ مدرک هم‌سطح با بالاتر ارائه نگردیده است.
"در صورت اثبات تخلف در هر زمان، مدرک تحصیلی صادر شده توسط دانشگاه از درجه اعتبار ساقط بوده و دانشگاه حق پیگیری قانونی خواهد داشت. "
کلیه نتایج و حقوق حاصل از این پایان نامه متعلق به مجتمع آموزش عالی لارستان می باشد. هر گونه استفاده از نتایج علمی و عملی، واگذاری اطلاعات به دیگران با چاپ و تکثیر، نسخه برداری، ترجمه و اقتباس از این پایان نامه بدون موافقت کتبی مجتمع آموزش عالی لارستان ممنوع است. نقل مطالب با ذکر ماخذ بلامانع است
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چکیده (سبک: عنوان چکیده)
[bookmark: _Toc326684642][bookmark: _Toc326703816](سبک: چکیده) در اين قالب، شيوة تهية ساختار پایان نامه با استفاده از امکانات استایل (سبک) نرم‏افزار وُرد براي مجتمع آموزش عالی لارستان شرح داده ميشود. روش قالب‌بندي پایان نامه، بخشهاي مختلف آن، انواع قلم‌ها و اندازه آنها، به‏طور كامل در سبک‏ها تهیه شده است و کافی است دانشجویان با کپی کردن متن و چسباندن (پِیست) آن در بخش‏های مختلف و انتخاب سبک مربوط، پایان نامه/ رساله خود را تهیه نمایند. پیشنهاد میشود که از ورد نسخه 2010 و بالاتر برای نگارش پایان نامه استفاده شود. فونت پیشنهادی برای چکیده بی نازنین و با اندازه 11 بوده و فاصله بین خطوط یک میباشد. (چکیده و کلمات کلیدی بایستی حتما در یک صفحه گنجانده شوند).   
پاراگراف اول و پاراگرافهای بعدی دارای تورفتگی از ابتدای پاراگراف میباشند. چكيده بايد بهطور صريح و شفاف، موضوع پژوهش و نتايج آن را مطرح كند. در چكيده از ذكر جزئيات كار، شكل‌ها، جدولها، فرمول‌ها، مراجع‌ و زیرنویس پرهيز شود.
ترتيب صفحات پايان‌نامه به صورت زیر است:
صفحه عنوان (مطابق فرم نمونه) 
صفحة بسم الله الرحمن الرحیم
تعهدنامه اصالت اثر
چكيده فارسي به همراه كلمات کلیدی (در يك صفحه)
فهرست مطالب 
فصول اصلی پایان‌نامه 
[bookmark: _Hlk75520114]مراجع
پیوست (در صورت نیاز)

کلمات کلیدی (سبک: عنوان چکیده)
(سبک: کلیدواژگان) سبک، کپی، حداقل 5، حداکثر 7 واژه، با جداکننده کاما 
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مقدمه (سبک: عناوین تک شمارهای)به اندازه 3/1 صفحه در ابتدای هر فصل فاصله داده شود.
(در سبک مربوطه لحاظ شده است.)

[bookmark: _Toc413744690][bookmark: _Toc413744942][bookmark: _Toc75520102]پیشگفتار (سبک: عناوین دو شماره‌ای)
(سبک: متن گزارش) نوع قلم مورد استفاده در تمامی متن گزارش، قلم فارسی بی نازنین با اندازه 12 و فاصله سطر 15/1 میباشد. همچنین قلم انگلیسی مورد استفاده، قلم کامبریا[footnoteRef:2] با اندازه 10 در متن گزارش و اندازه 8 در پاورقی میباشد. با توجه به تنظیم نوع صفحه و فواصل از اطراف، بهتر است دانشجویان محترم برای آمادهسازی پایان نامه خود از همین قالب استفاده نمایند. بدین منظور کافی است دانشجویان محترم، یک کپی از این فایل را در قسمتی از رایانه ذخیره نمایند و پس از آن با کپی و سپس چسباندن[footnoteRef:3] (پِیست) متن خود در این فایل، سبک[footnoteRef:4] مربوط را انتخاب نمایید. [2:  Cambria  (سبک: زیرنویس)]  [3:  Paste]  [4:  Style] 

همه پاراگراف‌ها با فرورفتگی به اندازة 5 میلی‏متر از شروع سطر و بدون فاصله پس یا پیش از پاراگراف است. 
[bookmark: _Toc75520103][bookmark: _Toc413353886][bookmark: _Toc413354063][bookmark: _Toc413744691][bookmark: _Toc413744943]فصول مختلف پایان‌نامه
(سبک: متن گزارش) متن هر پايان‌نامه شامل چندين فصل و هر فصل شامل چندين بخش خواهد بود. تعداد فصل‌ها و عناوین آنها بنا به نظر دانشجو و تائيد استاد راهنما مطالب مختلف پايان‌نامه تعیین مي‌شود. اما به عنوان مثال می‌توان فصل‌های زیر را برای سازمان‌دهی پایان‌نامه در نظر گرفت:
· مقدمه
· پیشینه تحقیق
· بیان مسئله، فرمول‌بندی و روش حل
· نتایج و بحث در نتایج
· نتیجه‌گیری و پیشنهادها
· مراجع
· پیوست‌ها
در ادامه به صورت مختصر برخی از قسمت‌های مهم هر فصل توضیح داده شده است.
مقدمه: (سبک: عناوین سه شماره‌ای) 
(سبک: متن گزارش) در اين قسمت، اهداف پايان‌نامه، اهميت موضوع، روش‌ها،‌ نحوه انجام تحقيق و به دست آوردن نتایج مورد بحث قرار مي‌گيرد. مرور منابع[footnoteRef:5] و پیشینه تحقیق را نيز می‌توان در اين قسمت قرار داد.  [5:  Literature Review] 

توضيح ساختار کلی پايان‌نامه در آخرین پاراگراف فصل مقدمه ضروري مي‌باشد.
 بیان مسئله، فرمول‌بندی و روش حل: (سبک: عناوین سه شماره‌ای)
(سبک: متن گزارش) در این فصل‌ مسئله مورد نظر طرح شده و روابط و جزئیات مربوط به آن بیان می‌شود. همچنین روش حل مسئله در این فصل توضیح داده خواهد شد.
نتایج و بحث در نتایج: (سبک: عناوین سه شماره‌ای)
(سبک: متن گزارش) نتایج به دست آمده در این قسمت بیان خواهد شد. همچنین پس از ارائه نتایج حاصل شده لازم است بحث در نتایج نیز انجام شود و به عبارت دیگر نتایج خام به دست آمده تجزیه و تحلیل شوند. توجه داشته باشید که این قسمت مهم‌ترین فصل پایان‌نامه است؛ لذا در ارائه جزئیات دقت کافی داشته باشید. 
بسته به موضوع و روش حل (یا بررسی) ممکن است ضروری باشد که پیش از ارائه نتایج، روش حل مسئله اعتبارسنجی شود. بدین منظور از روش ارائه شده خود، برای حل مسئله مشابهی که پیش از این حل شده استفاده ‌کرده و نتایج روش حل خود را با نتایج پژوهش‌های قبلی مقایسه کنید. پس از کسب اطمینان از صحت و دقت روش ارائه شده، می‌توان از آن برای تولید نتایج جدید و مطالعات بعدی استفاده نمود. 
نتیجه‌گیری و پیشنهادها: (سبک: عناوین سه شماره‌ای)
(سبک: متن گزارش) در این قسمت نتایج به دست آمده از پایان‌نامه به صورت خلاصه بیان می‌شود. همچنین با توجه به پژوهش‌ انجام شده حاضر، نتایج به دست آمده و زمینه‌های باقیمانده برای پژوهش، در راستای پایان‌نامه خود پیشنهادهایی برای پژوهش‌های آتی ارائه دهید. 
مراجع (سبک: عناوین دو شماره‌ای) 
(سبک: متن گزارش) 	بطور كلي چنانچه از منبعي براي مطلبي استفاده شود ذكر ماخذ لازم و ضروری است. در اينگونه موارد بایستی بلافاصله پس از بیان مطلب با استفاده از شماره به آن مرجع اشاره نمود. اشاره به مراجع با علامت [1] در متن پایان نامه شروع می‌شود و بقیه مراجع نیز به ترتیب ادامه می‌یابند. مراجع باید به ‌ترتیب ارجاع در متن شماره‌گذاری شوند و نمی‌توان به مرجع شماره 3 زودتر از مرجع شماره 2 اشاره کرد. در اشاره به چند مرجع پشت سر هم، به جای ذکر تکتک آنها می‌توان به صورت یکجا به آنها اشاره نمود [2-4] و برای اشاره به دو یا چند مرجع غیر متوالی در داخل براکت از جداکننده کاما استفاده می‌شود [7،5،2]. از ارجاع به مراجع به صورت: "در این موضوع محققان بسیاری تحقیق نمودهاند [2-20]" خودداری شود. 
هر ادعاي ارائه شده در صورتي‌كه نوآوريِ اين پژوهش نيست بايد مرجع ‌نگاري شده باشد. هیچ بندي كه اشاره به‌كار ديگران دارد نبايد بدون مرجع نگاري ارائه شود.

[bookmark: _Toc413353887][bookmark: _Toc413354064][bookmark: _Toc413744692][bookmark: _Toc413744944][bookmark: _Toc75520104]اعداد و کلمات انگليسي (سبک: عناوین سه شماره‌ای)
(سبک: متن گزارش) اعداد به کار رفته در پایان نامه بایستی دارای شکل واحد (فارسی یا انگلیسی) باشند. دانشجویان محترم بایستی دقت نمایند که در وارد کردن اعداد به صورت فارسی و انگلیسی قواعد معمول را رعایت نمایند. (مثال: 124/2 به صورت فارسی و 2.124 به صورت انگلیسی صحیح است).
همه کلمات زبانهای بیگانه که معادل فارسی ندارند، بایستی با الفبای فارسی نوشته شوند. در صورت لزوم، اصل انگليسي کلمات به‌صورت زیرنویس اشاره شود. اشاره به زیرنویس با اعداد فارسی بوده و در هر صفحه از مقاله با عدد 1 شروع می‌شود. باید توجه کرد که از زیرنویس وقتی استفاده می‌شود که اولینبار آن کلمه در متن پایان نامه استفاده می‌شود و در دفعات بعدی نیازی به تکرار زیرنویس نیست. 
به خاطر داشته باشید در صورتی که شمارههای تایپ شده در متن فارسی را انگلیسی میبینید، لازم است تا با استفاده از این مسیر 
File -> Options -> Advanced -> Show document content -> Numeral -> Context
این روند را اصلاح نمایید به نحوی که ارقام فارسی به صورت فارسی و ارقام انگلیسی به صورت انگلیسی ظاهر شوند.
برای نگارش زیرنویس، از قسمت Styles، سبک زیرنویس را انتخاب نمایید.
[bookmark: _Toc413353888][bookmark: _Toc413354065][bookmark: _Toc413744693][bookmark: _Toc413744945][bookmark: _Toc75520105]نسخه نهایی تحویلی به کتابخانه (سبک: عناوین دو شمارهای)
دانشجویان محترم بایستی پس از انجام اصلاحات احتمالی اعلام شده در جلسه دفاع، نسخه نهایی را مطابق همین فرمت در قالب فایل ورد[footnoteRef:6] و پی‌دی‌اف[footnoteRef:7] تهیه و به کتابخانه تحویل نمایند. [6:  word]  [7:  pdf] 








[bookmark: _Toc413353889][bookmark: _Toc413354066][bookmark: _Toc413744694][bookmark: _Toc413744946][bookmark: _Toc75520106]شکلها، نمودارها، جدولها و روابط (سبک: عناوین تک شمارهای)
[bookmark: _Toc413353890][bookmark: _Toc413354067][bookmark: _Toc413744695][bookmark: _Toc413744947][bookmark: _Toc75520107]شکلها و نمودارها (سبک: عناوین دو شماره‌ای)
(سبک: متن گزارش) در تهیه شکلها و نمودارها نکات زیر را رعایت نمایید:
· شکل‌ها بایستی به صورت وسط چین قرار گیرند. پیشنهاد می‌شود بدین منظور در قسمت Styles، از سبک شکل استفاده نمایید.
· شكل‌ها و نمودارها بايد داراي عنوان باشند. عنوان شكل‌ها در زير شكل قرار مي‌گيرند.
· شكلها بايستی داراي يك شماره باشند كه این شماره در هر فصل پایاننامه از 1 شروع مي‌شود. روش شمارهگذاری شکلها به صورت "شماره فصل- شماره شکل" است. به عنوان مثال، شکل سوم از فصل پنجم به صورت شکل 5-3 شمارهگذاری میشود. پیشنهاد می‌شود بدین منظور عنوان شکل را نوشته و از قسمت Styles، سبک شماره شکل را انتخاب نمایید. بدین ترتیب شماره‌گذاری به صورت اتوماتیک صورت می‌گیرد.
· تمام شكل‌ها بايد در متن مورد ارجاع قرار گيرند. هیچ کدام از شکلها نبايد قبل از ارجاع در متن ظاهر شوند.
· در هنگام ارجاع به شكل از شماره آن استفاده كنيد و از به كار بردن عباراتي هم‏چون «شكل زير»، «شكل یاد شده» و عبارات مشابه که شماره شکل را شامل نمیشود، پرهيز نمایید. 
· در صورتي كه از شكل‌های ساير مراجع استفاده مي‌کنيد، بايد حتماً شماره مرجع آن را در عنوان شكل ذكر كنيد.
· ارجاع‌دهی به شکل‌ها به دو صورت دستی و اتوماتیک امکان‌پذیر است. برای ارجاع اتوماتیک می‌توان از مسیر زیر اقدام نمود:
References -> Cross- reference
در بخش reference type گزینه Numbered Item  را انتخاب نموده، از قسمت Inset refrence to گزینه Paragraph number را انتخاب نموده، و در بخش For which numbered item  شماره شکل و یا نمودار مربوطه را انتخاب نمایید. به تنظیمات انجام شده در ‏شکل(2-1) توجه کنید.
[image: ]
[bookmark: _Ref74572570]تنظیمات جهت ارجاع‌دهی به شکل‌ها
[bookmark: _Toc413353892][bookmark: _Toc413354069][bookmark: _Toc413744697][bookmark: _Toc413744949][bookmark: _Toc75520108]جدولها (سبک: عناوین دو شماره‌ای)
در تهیه جدولها نکات زیر رعایت شود. 
· جدولها باید در يك خط جداگانه با حالت وسط‌چين درج شوند.
· برای تهیه جدولها، حتما از ابزار Table در نرمافزار Word استفاده نمایید و از بکار بردن جدول به صورت عکس در پایان نامه پرهیز نمایید.
· سرستون‌های جداول، متون داخل آنها و سایر موارد باید به زبان فارسی و با قلم بی نازنین در اندازه 10 تهیه شوند. اندازه قلم برای پارامترهای انگلیسی و لاتین، 9 با نوع قلم کامبریا میباشد. پیشنهاد می‌شود بدین منظور برای مطالب درون جدول از قسمت Styles، سبک متن جدول انتخاب نمایید. 
· جدولها بايد داراي شماره و عنوان باشند که در بالاي جدول قرار مي‌گيرد. 
· تعیین شماره برای جدولها در هر فصل از پایان نامه با آغاز از 1 ضروری میباشد. روش شمارهگذاری جدولها به صورت "شماره فصل- شماره جدول" است. به عنوان مثال، جدول سوم از فصل پنجم به صورت جدول 5-3 شمارهگذاری میشود. پیشنهاد می‌شود بدین منظور عنوان جدول را نوشته و از قسمت Styles، سبک شماره جدول را انتخاب نمایید. بدین ترتیب شماره‌گذاری به صورت اتوماتیک صورت می‌گیرد.
· تمام جدولها بايد در متن مورد ارجاع قرار گيرند بطوریکه بعد از ارجاع در متن، جدول مربوطه قرار داده شود.
· در هنگام ارجاع به جدولها در متن اصلی مقاله از شماره جدول استفاده كنيد و از به كار بردن عباراتي همچون «جدول زير»، «جدول یاد شده» و یا عبارات مشابه بدون ذکر شماره جدول، پرهيز نمایید. 
· ارجاع‌دهی به جداول به دو صورت دستی و اتوماتیک امکان‌پذیر است. برای ارجاع اتوماتیک می‌توان از مسیر زیر اقدام نمود:
References -> Cross- reference
در بخش reference type گزینه Numbered Item  را انتخاب نموده، از قسمت Inset refrence to گزینه Paragraph number را انتخاب نموده، و در بخش For which numbered item  شماره جدول مربوطه را انتخاب نمایید.
· در صورتيكه از جدولهای ساير مراجع استفاده شود، ذکر شماره مرجع در عنوان جدول ضروری میباشد. همچنین در صورتی که در قسمتی از جدولها از دادههای ساير مراجع استفاده شود، ذکر شماره مرجع در سر ستون جدول ضروری میباشد.
· ‏جدول(2-1) نمونه قابل قبول جدول با اعداد فارسی و ستونبندی گروهی میباشد. ‏جدول(2-2) نمونه قابل قبول برای جدول با اعداد انگلیسی و سطربندی گروهی میباشد. 
·  از بکار بردن جدول به صورت عکس در پایان نامه پرهیز نمایید. به عنوان مثال ‏جدول(2-3) نمونه نادرست جدول را نشان می‏دهد که به صورت عکس از مراجع دیگر آورده شده است. 
[bookmark: _Ref413314347]نمونه جدول با اعداد فارسی و ستونبندی گروهی (سبک: شماره جدول)
	سرستون اول (سبک : متن جدول)
	سرستون دوم (mm)
	
	فونت 10 (kgm-2)
	
	... چهارم (Nm)

	
	گروه اول
	گروه دوم
	
	گروه اول
	گروه دوم
	
	گروه اول
	گروه دوم

	کمیت یک
	123
	125
	
	-
	01/0
	
	239
	234

	کمیت دو
	75
	76
	
	45
	45/45
	
	990
	25/987

	فونت 10
	78
	80
	
	345
	348
	
	18/0
	12/0


[bookmark: _Ref413314363]نمونه جدول با اعداد انگلیسی (سبک: شماره جدول)  
	سرستون اول (سبک : متن جدول)
	
	سرستون دوم (mm)
	فونت 10 (kgm-2)
	...... چهارم (Nm)

	کمیت یک
	گروه اول
	12.1
	470
	45
	950.1
	780

	
	گروه دوم
	12.2
	475
	55
	955
	787

	
	گروه سوم
	12.3
	490
	65
	957
	800

	کمیت دو
	گروه اول
	543
	550
	34
	978
	978

	
	گروه دوم
	545
	700
	70
	988
	960

	
	گروه سوم
	560
	710.01
	75
	990
	950.1



	[bookmark: _Ref412032662]غیرقابل قبول به دلیل ارائه جدول به صورت عکس (سبک: شماره جدول)  

	[image: ]



روابط و فرمولهای ریاضی (سبک: عناوین دو شماره‌ای)

روابط و فرمولهای ریاضی با استفاده از ابزار معادله[footnoteRef:8] موجود در نرمافزار آفیس با قلم کامبریا مث[footnoteRef:9] 11 و از سمت چپ تایپ می‌شوند و با شماره‏گذاری از یک مشخص شده و برای اشاره به آنها از شماره فرمول در داخل پرانتز استفاده می‌شود. یادآور میشود در نسخههای 2007 به بعد نرمافزار آفیس، فونت کامبریا مث به طور پیشفرض برای نوشتن روابط و فرمولها بکار رفته و کافی است اندازه آن در ابزار معادله تغییر کند. همچنین برای تنظیم اندازه و فونت مناسب کل فرمول‌ها می‌توانید در قسمت Styles از سبک معادله استفاده نمایید. [8:  Insert -> Symbols -> Equation]  [9:  Cambria Math] 

در نوشتن فرمولها رعایت نکات زیر پیشنهاد میشود:
· بهتر است برای جلوگیری از جابجایی روابط و شماره مرتبط با آنها، ابتدا جدولی دو ستونی از مسیر Insert->Table  ایجاد شود و سپس روابط و شماره آنها درون جدول قرار داده شود. و از مسیر Design-> Borders-> No Border خطوط جدول محو شود. 
· در صورتی که فرمول طولانی باشد و طول آن از یک سطر تجاوز کند، باید در جای مناسب شکسته شده و ادامه فرمول در سطر بعدی آورده شود و از فشرده کردن آن پرهیز شود. 
· شماره هر فرمول در گوشه سمت راست آخرين سطر فرمول درج مي‌شود و در صورتی که در سطر آخر برای نوشتن شماره فرمول جا نباشد، در گوشه سمت راست سطر بعد نوشته می‏شود. 
	(2-1)
	

	

	(2-2 الف)
	

	

	
	          
          

	(2-2 ب)
	

	(2-3)
	

	(2-4)
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[bookmark: _Toc413353895][bookmark: _Toc413354072][bookmark: _Toc413744700][bookmark: _Toc413744952][bookmark: _Toc75520110]قواعد نوشتاري (سبک: عناوین تک شماره‌ای)
[bookmark: _Toc413353896][bookmark: _Toc413354073][bookmark: _Toc413744701][bookmark: _Toc413744953][bookmark: _Toc75520111]مقدمه (سبک: عناوین دو شماره‌ای)
تلاش شود در متن پایان‌نامه از جملات رسا، گويا و كوتاه استفاده شود و از نوشتن جملات تودرتو پرهيز شود. جداسازي اجزاي مختلف يك جمله نيز نقش زيادي در فهم آسان آن دارد. درستي نوشتار بر پاية املاي زبان پارسي ضروري است. در اين بخش، برخي از قواعد نوشتاری يادآوري مي‌شوند. 
موقع استفاده از علایمی نظیر ، : . ؛ و غیره، به خاطر داشته باشید که کلیة این علایم بدون فاصله از حرف قبلی و با یک فاصله از حرف بعدی نوشته می‌شوند.
در افعال حال و گذشته استمراري بايد دقت شود كه «مي» از جزء بعدي فعل جدا نماند. براي اين منظور از «فاصلة متصل» استفاده كنيد. براي نوشتن فاصلة متصل از «كليد Ctrl» به همراه «كليد -» استفاده كنيد. همچنين دقت كنيد كه جزء «مي» و جزء بعدي فعل را بهصورت يكپارچه ننويسيد. بنابراين «مي شود» و «ميشود» اشتباه، و درست آن «ميشود» است.
در مورد «ها»ي جمع نيز دقت كنيد كه از كلمة جمع بسته شده جدا نوشته شود. براي جدانويسي نيز از فاصلة متصل استفاده كنيد. مثلاٌ «شکل ها» را بهصورت «شکل‌ها» بنويسيد. 
در تمام گزارش تنها و تنها از يك نمادگذاري واحد استفاده نماييد.
[bookmark: _Toc407184081]قبل از پرانتز باز، گیومه باز و کوتیشن باز باید تنها یک فاصله وجود داشته باشد و به کلمه بعدی چسبیده باشد. همچنین پرانتز بسته، گیومه بسته و کوتیشن بسته به کلمه قبلی چسبیده و از کلمه بعدی تنها یک فاصله داشته باشد.
[bookmark: _Toc413353897][bookmark: _Toc413354074][bookmark: _Toc413744702][bookmark: _Toc413744954][bookmark: _Toc75520112]مراجع (سبک: عناوین تک شمارهای)
تمامی مراجع با قلم کامبریا 9 نوشته میشوند. شماره مرجع داخل کروشه و با ایجاد بیرونزدگی 5 میلی‏متر از خط دوم هر مرجع، نوشته میشود. برای تنظیم اندازه و فونت مناسب می‌توانید از قسمت Styles از سبک متن مراجع استفاده نمایید.
 در ادامه چند مثال از نحوه ارجاع به نام نشریه [1, 2]، نام کتاب [3, 4]، عنوان کنفرانس [5] و عنوان پایان‏نامه یا رساله [6] آورده شده است. دقت نمایید که بایستی در متن پایان‌نامه به تمامی این مراجع اشاره شده باشد.
برای نگارش مراجع می‌توانید از نرم‌افزار End Note استفاده نمایید. مراجع این شیوه‌نامه به کمک همین نرم‌افزار و با سبک IEEE نوشته شده‌اند.
[1]	A. Kumar and R. Shrivastava, "Free vibration of square laminates with delamination around a central cutout using HSDT," Composite Structures, vol. 70, no. 3, pp. 317-333, 2005.
[2]	J. W. Pratt, L. E. Klebanoff, K. Munoz-Ramos, A. A. Akhil, D. B. Curgus, and B. L. Schenkman, "Proton exchange membrane fuel cells for electrical power generation on-board commercial airplanes," Applied energy, vol. 101, pp. 776-796, 2013.
[3]	T. W. Clyne and D. Hull, An introduction to composite materials. Cambridge university press, 2019.
[4]	S. W. Tsai and H. T. Hahn, Introduction to composite materials. Routledge, 2018.
[5]	V. P. Carey, "Modeling of microscale transport in multiphase systems," in International Heat Transfer Conference Digital Library, 1998: Begel House Inc.
[6]	J. Latt, "Hydrodynamic limit of lattice Boltzmann equations," University of Geneva, 2007.







[bookmark: _Toc413353898][bookmark: _Toc413354075][bookmark: _Toc413744703][bookmark: _Toc413744955][bookmark: _Toc75520113]پیوست أ (سبک: عناوین تک شمارهای)
مقدمه (سبک: پيوست - عناوین دو شماره ای)
(سبک: متن گزارش) قسمت اصلي متن پايان نامه نبايد داراي داده هاي غير ضروري باشد. موارد جانبی که در متن پایان‌نامه به آنها اشاره می‌شود بایستی به گونه‌ای باشد که ساختار کلی پایان‌نامه را دچار اشکال نکند. اگر حجم چنین مطالبی زیاد است، بهتر است آنها را در قسمت پیوست بیان کرد. هرگونه توضیحات اضافه از نظیر کدنویسی‌های انجام شده، چگونگي به دست آوردن معادلات رياضي و اثبات آنها پرسش‌نامه ها و داده‌های تجربیو مواردی از این دست از جمله مطالبی هستند که می‌توانند در قسمت پیوست قرار گیرند.
کلیه دستورالعمل‌هایی که پیش از این در خصوص نگارش متن، شکل‌ها، جداول و روابط ریاضی بیان شد در این قسمت نیز بایستی رعایت شوند. 
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